Help Guide

Welcome to the Nuventive Improvement Platform Help Guide. This
Help Guide will walk you through the structure and navigation of the
Nuventive Improvement Platform screens.
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! Nuventive.

WELCOME

Welcome to the Nuventive Improvement Platform Help Guide. The purpose of this help guide is
to walk you through the navigation of the Nuventive Improvement Platform. The current
configuration of the system was established by workgroups of the Program Review and
Outcomes Assessment Committees. Visit the Nuventive information page on SAC.edu for
additional information.

BASIC NAVIGATION

Accessing the Nuventive Improvement Platform is simple and straight forward. Navigate to
https://sac.edu/Nuventive. Once you have logged into the Nuventive Improvement Platform, non-
academic areas will see the Santa Ana College logo, while academic areas will see a dashboard
similar to the one below.

Example: Improvement Analytics Dashboard

E Academic Affairs - Nursing | v -

l Nuventive. |mprove Ana|ytic5 Active Student Learning Outcomes (SLOs) Overview

Semester of Assessment

All W

Active SLOs Active SLOs Assessed Active SLOs Assessed (%)
-

Academic Affairs - Nursing a9 1 1.1%
NRMN-170 7 1] 143%
NCE-145 1 0 0.0%
MNRM-008 1 0 0.0%



https://sac.edu/committees/IEA/Pages/Nuventive.aspx
https://sac.edu/Nuventive
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TOP NAVIGATION BAR & ICONS

At the top of the screen, you will find two sets of icons (to the left and right) and a dropdown in
the center. This is the primary navigation bar throughout the platform.

= i m

Main Menu E

Unit Drop-
down

Program - Psychology (BA)

Data

View/Split
Documents

& Reports

Instructions @

Ellipsis :
Plus (+) o
Sign
Hide Hide T

Unhide Unhide 1

THE UNIT DROP-DOWN

The center unit drop-down is where you will locate your units. By selecting the down arrow to the
right in the drop down you will be able to see the units that are available to you. If this is your first
time logging in, and you do not see your unit, please contact your department chair or
administrator. You may also type in the dropdown box to quickly locate a unit.

= e Feyehelear G4 m
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THE MAIN MENU

Now that you have found your unit, select the menu

Home icon on the left to reveal your platform menu.
NOTE: Your main menu will differ depending on the

Assign Users permissions you have in the system. You may not
see every option. Visit the USER ASSIGNMENT AND

Program Information ROLES section of this manual for more information.

Course Qutcomes Assessment '

Program Outcomes Assessment W

End-of-Program Outcomes Assessment v

Program Review v

Resource Allocation Requests (RAR) v

Reports v

Document Library

SPLIT SCREEN/DOCUMENTS AND REPORTS

To the far right of the navigation bar, you will find a set of icons referred to as Split
Screen/Documents & Reports. Under the icons, a space is provided for various
documents/reports to be viewed. This area can house the following types of documents: Word,
PDF, Excel, Video, HTML, Power Bl Reports, etc. The purpose of this area is to provide you with
information for your reference to complete tasks in the Nuventive Improvement Platform. Each
of the icons represent the amount of space to be taken up on the screen (split-screen view) when
selecting and opening an item in the list. This expansion allows you to view the information
provided in this area from an intelligible viewpoint.
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The following are examples of the expanded Split Screen/Documents & Reports areas.

View 1.
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| for Filters
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Report Instructions
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Program Learning Outcomes (PL...
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View 2.
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Showing 1 of 1
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View 3.

Academic Affairs - Nursing
Resource A

Resource A

| Santa Ana College
Request Typg Education Mastnrl:lan

View All 2021 - 2024

Use the far
form for ea

you may ag .;_ -

SAC Education Master Plan 2021.. AR 6601 Facility Modification an... SOP_FMR Process_Final 6_1_22...

Instructions
cycle by the

Administrat
fiscal year B

No Resource /
add but FY23.24 SAC Budget Priorites.pdf Cost of Position Worksheets_FY...

NOTE: The area will also expand to the first level of expansion by selecting a document/report
from the list. You can expand further, or minimize the view of the document/report, by again
Selecting one of the icons.

OTHER IMPORTANT NAVIGATION

Throughout the Platform, wherever you see this icon, instructions may have been
@ provided for that specific field, item, or area. Selecting the icon will reveal any
instructions that have been made available.

Throughout the Platform, wherever you see this icon, options will be presented by
selecting the ellipsis. Typical options include: Open, View/Print, Copy, and/or
Delete.

° Throughout the Platform, wherever you see this icon is where you will select to
Add a NEW Goal, Outcome, Objective, or other element to that screen.

Hide T In several places throughout the Platform, you will find these icons. Selecting the
icon allows you to choose between leaving the highlighted information available
as you enter information, or you can select the Hide icon to hide the information.

Unhide £ ynhide allows you to uncover the highlighted information.
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PROGRAM/GENERAL INFORMATION FORM

PROGRAM/GENERAL INFORMATION

The Program/General Information Form is where you will enter information about the institution,
college, department, program, and/or unit, such as the Mission Statement. The form is called the
Program Information Form for instructional units, and the General Information From for non-
instructional units. The Program/General Information form will appear as the second page on
standard reports.

To enter information on the form, begin by selecting the green circle with the plus (+) sign icon

on the card. o

= Continuing Education - Home Economics

Program Information

No responses have been entered. Please click the add button o to create a response

Once selected, the form will open to the following view.

Continuing Education - Home Economics

Program Information > .: Program Information - Add New Response

* denotes a required field.

2}

.: Program Information 7|z COLLAPSE ALL
v Program Information I
|
Mission
K
Manager / Dean
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Complete the form fields/text boxes, as designated, by selecting in the text box or selecting from
the drop - down. NOTE: If you see an Asterisk (*) next to the name of a field on any form, that field
is required, and you will not be able to save the form until information has been entered into that
field. Next, SAVE, by selecting the SAVE button at the top of the screen.

Once you have saved the form, you should see the completed information as depicted below.

President’s Office - Student Information Support

General Information > General Information (Student Services, Admin and Acdemic Support Services)

7 ¥ COLLAPSE ALL

v General Information Last Modified: 11/09/2022, J. Steffens

" denoles g requirea nield.

Mission

To inspire and empower digital transformation at Santa Ana College.

Manager / Dean

John D. Steffens

Once you are satisfied with the information you have entered, and have saved the form, select
the Close button at the top of the screen. You will now see the following view of the form.

President’s Office - Student Information Support

General Information

View All b4

General Information Last Modified: 11/09/2022, J. Steffens :
Mission
To inspire and empower digital transformation at Santa Ana College.

Manager / Dean

John D. Stefiens

If at any time you need to edit, copy, view/print, view the audit log, or delete the form, select the
ellipses on the top right of the Program/General Information form.
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PROGRAM REVIEW

If your permissions allow, you may see other forms such as Outcomes Assessment, Program
Review, and/or Resource Allocation Requests (RARs). You may see these headings in your main
menu. For this example, we are using an Annual Program Review.

| ANNUAL PROGRAM REVIEW |

The annual program review form is accessed from the main navigation under the Program
Review heading. Some areas will also have a Capstone (formerly Quadrennial) Review option.

Program Review ~

Capstone Program Review
Annual Program Review
Goals and Status Updates

Goal Mapping

While the overall function of entering information on this form will be the same as the General
Information form, there are some differences such as selecting from multiple date cycles.

Program Review > Annual Program Review

. ©

No responses have been entered. Please click the add button o to create a response

Select the cycle from the drop-down provided after selecting the add button L . Then, proceed
with completing that form. Once you have completed the fields within the form, remember to
SAVE your work and Close the form.

10
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Once closed, each cycle will be exhibited as indicated in the graphic below. Notice that in the
example the drop-down is set to View All. This means that you will see all cycles that have data
on this form. You may choose a specific cycle such as 2021 - 2022 from the drop-down to filter
your view. In that case you will only see that cycle of information.

President's Office - Student Information Support

Program Review > Annual Program Review

View All
View All @
2022-2023 Last Modified: 11/2
Incomplete
2023-2024 et
Progral
2022-2023
2021-2022 Last Modified: 1177 20212022

You can always edit your data by selecting the Open or Edit option from the ellipsis * menu:

Program Review > Annual Program Review
View Al | v @

2022-2023 Last Modified: 11/13/2023, M. Valerius g /" Edit

|_D Copy
t=n View/Print
E Audit Log

O Delete

The Audit Log option will provide you with a report of changes that have been made to this
form. This can be helpful when multiple people have access to edit the data on the form.

11
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Audit For Cycle: 2022-2023, Response 141

‘Show activity from the
Show All Activity ‘ v
ety Fersonn Field 0ld Value New Value
J. Hoeger ;Esg’ﬁ’ess Report: Review Previous Year's Institutional Click to see comparison of old and new value
J. Hoeger ;essﬁress Report: Review Previous Year's Insfitutional Click to see comparison of old and new value
J. Hoeger ;;;’3’“5 Report: Review Previous Year's Institutional Click to see comparison of old and new value
N. Gallegos ;essﬁress Report: Review Previous Year's Insfitutional Click to see comparison of old and new value
J. Hoeger 2. Provide effective data sources to evaluate this Click to see comparison of old and new value
department
J. Hoeger 2. Provide effective data sources to evaluate this Click to see comparison of old and new value
department
N. Gallegos 2. Provide effective data sources to evaluate this Click to see comparison of old and new value
department
J. Hoeger Please attach any data sources here. 1297 1056

PROGRAM GOALS

Program Goals are entered under the Goals and Status Updates menu option in your Program
Review menu.

Program Review ~
Capstone Program Review
Annual Program Review
Goals and Status Updates

Goal Mapping

To add a new goal, select the green circle with plus (+) sign © on the top right.

12
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Program Review > Goals and Status Updates O

Program Review Goals o ;
Expected Completion Goal Status
View All ‘ v View All v

This will open the following card:

Program Review > Goals and Status Updates

New Goal

" GOAL UPDATES

* denotes a required field

Goal Name *

Goal *

Rationale for Creating Goal

Goal Status

Responsible Party(ies)

Objectives @

Expected Completion

Next, type in each field provided to enter the Goal Name and Goal. Complete the Goal Status
Expected Completion fields to be able to filter goals on those values later.

Note: Where you see an Asterisk (*) next to the name of a field, that field is required, and you will
not be able to Save the card until information has been entered into that field.

Once you have completed entering the goal information, SAVE your work by selecting the Arrow
next to the SAVE button at the top of the screen. Notice that when you select the Arrow on the
SAVE button you are provided with the options to Save & Add New or Save & Close this goal. If
you have additional goals to add, select the Save & Add New option. If you have finished adding
goals, select the Save & Close option.

13
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Program - Psychology (New Plan Types)

PROGRAM GOALS » Program Goals » Add Goal

New Goal B Save & Add New

« Save & Close it
GOAL )

Goal Name *

Sample

Goal * Graduation Rates (Tableau)

Sample

Goal Status *
Active

Goal Year(s)
2021-2022 x @

Once you have finished adding goals, select the Save & Close option. The following screen will
appear showing the goals that you have added.

Program Review > Goals and Status Updates

Program Review Goals o :

Expected Completion
View All |v

Showing 130f 13

ii Student Business Office Training J. Adams 10/12/22 %

Goal
Create and deliver a robust purchasing training program for departments utilizing Auxiliary Funds

Expected Completion
Spring 2023

Objectives
Review current practices/process, document processes, create a training document, create a training presentation, schedule training with departments

ii Student Business Office Payment Pages J Adams 11/21/23 &

NOTE: As you add goals, the number of goals that have been entered is reflected at the top,
right, of the goals/cards. In this example you see “Showing” 13 of 13.

14
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Program Review Goals o :
Expected Completion
View Al |v
Showing 130f 13
it Student Business Office Training J. Adams 10/12/22 %
Goal

Create and deliver a robust purchasing training program for departments utilizing Auxiliary Funds

Expected Completion
Spring 2023

Objectives
Review current practices/process, document processes, create a training document, create a training presentation, schedule training with departments.

it Student Business Office Payment Pages J Adams 11/21/23 &

To edit a current goal, locate the ellipsis to the far right of the card.

Once you select the ellipsis you will be provided with the options to Open, Copy, Audit or Delete
the goal. Keep in mind that if there have been results entered for any goal/objective/outcome,
deleting any goal will also remove any results that have been entered for that specific goal.

Program Review > Goals and Status Updates

~
Program Review Goals o :

Expected Completion
View Al | v

Showing 13 of 13

i Student Business Office Training /" Open

Goal rD Copy
Create and deliver a robust purchasing training program for departments utilizing Auxiliary Funds

Expected Completion Audit Log
Spring 2023

Objectives 'lj' Delete

Review current practices/process, document processes, create a training document, create a training presentation, schedule ti

ARCHIVING GOALS

If a previously entered goal is no longer relevant, either because it has been completed or
abandoned, it is recommended that you do not delete it as that removes historical data for your
program. Instead, open the goal and change the goal status to “Archived.”

15
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ENTERING GOAL UPDATES/RESULTS

The next Tab on the navigation bar for this goal is the GOAL UPDATES(s) page/screen. To add a

Goal Update for the goal, select the green circle with the plus (+) sign o

Program Review > Goals and Status Updates

Q, Student Business Office Training

Goal Progress

Reporting Period
|v  Vviewal v

View All
Showing 1of 1

GOAL "= UPDATES

Student Business Office Training

2022 - 2023 J. Adams 7/26/23

Goal Status Update
The documentation process is still underway. Once the manual is complete a training schedule will be implemented.

Once you have selected the green circle with the plus (+) sign o the following card/screen will
open. To see the information that was entered previously for the goal, you can choose can select

ol s Show Details 1
the Show Details icon: '

16
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Program Review > Goals and Status Updates

Chemistry Lab

Show Details 1

* denotes a required field.

Reporting Period *
Goal Status Update *
Goal Progress *

Percent Complete *

Supporting Documents

Document Mame Document Description o
There are no documents attached

Optional Tables and/or Graphs Press ALT + 0 for accessibility help

Now, begin entering the Status Update/Results for this Goal. First, select the Reporting Period by
selecting the drop-down. Then, select in the text/dialog box to enter the Goal Status Update
narrative. Next, select the dropdowns to select your Goal Progress and Percent Complete. Finally,
use the scroll bar to the right to add any Optional Information and/or Supporting Documents.

To add Optional Information, select in the text/dialog box. Once you select in the text/dialog box
a typical Word toolbar will appear. You have a variety of options such as pasting from a Word
document, adding a table, linking to a document outside of the platform, or pasting a
graphic/picture from another sources.

17
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Optional Information

Supporting Information

M=

=
b
m
It
I
mr
i
i

- Normal - B I

Adding Supporting Documents

To add Supporting Documents, Select the green circle plus + sign ©

Supporting Documents

©

There are no documents attached

The following screen for the Document Repository will appear. Select the primary folder to open
the Document Library folders where this document has been stored.

Document Repository

f

(I | Academic Affairs Program Sample

Now select from the folder options available. In this example there is one folder titled General.

18
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Document Repository

‘ﬁ > ACADEMIC AFFAIRS PROGRAM SAMPLE

[} General

Select the folder name to open that folder. Then, select a file (or files) from that folder by
selecting the checkbox next to each file you would like to add.

Document Relate Repository ATTACH O X

ﬁ > PROGRAM - PSYCHOLOGY (NEW PLANTYPES) > GENERAL

D D coming-soon-v2.png

D @ Sample Outcome Evidence.docx

ATTACH
Now select from the from the top right-hand navigation.

19
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Program - Psychology (New Plan Types)

Document Relate Repository

ﬁ > PROGRAM - PSYCHOLOGY (NEW PLAN TYPES) > GENERAL

D D coming-soon-v2.png

D @ Sample Qutcome Evidence.docx

Note: If the folder, or file, is not available in the Document Library/Repository, you can add a
folder and/or file, right from this screen by selecting one of the icons next to the Attach icon.

o o

More on the Document Library/Repository later in this Help Guide.

You should now see the file attached as a supporting document.

Supporting Documents

Document Name Document Description o
Add

Sample Outcome Evidence.docx )¢

Once you are satisfied with the information you have entered Select and choose

B Save&Add New

—

« Save &Close

_ to Save & Add New or Save & Close.

The Save & Add New will allow you to continue adding Updates/Results to other goals. The
Save & Close will take you back to the main goal page.

20
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GOAL MAPPING

Select GOAL MAPPING from the Program Review menu to navigate to the Mapping screen
where the unit can map Goals with other institutional outcomes such as Institutional Learning
Outcomes (ILOs), Comprehensive Ed. Plan Goals or Guided Pathways Pillars. To begin, select
the institutional outcome from the drop-down immediately above the left-most column. To map
a goal, select in the box that forms the intersection between the goal and the outcome. The
example below shows a Chemistry Lab goal mapped to ILO 1b.

Academic Affairs Program Sample

Program Review > Goal Mapping

Expected Completion
View All v
Santa Ana College
Education Master Plan
2021 - 2024

To establish a mapping relationship, click on the cell to turn it green, then click save. If text is truncated, please hover over the three X ':'-_l;.I
dots and the full text will appear.
For additional information on Guided Pathways, please visit the SAC Guided Pathways webpage —_—

Program Review Goals Add Note C Education Master Plan 20

X=X

~
Institutional Learning Outcomes ... | v Chemistry Lab ZTC /OER

Upgrade the equipment in the chemistry lab Create additional resources.
as well as revise curriculum to address
latest chemistry lab techniques.

ILO 1a - Communication Skills:
Listening and Speaking

Students will listen actively and respectfully
to analyze the substance of others’
comments. Students will speak in an
understandable and organized fashion to...

ILO 1b - Communication Skills:
Reading and Writing

Students will read effectively and analytically
and will comprehend at a college level.
Students will write in an organized and
grammatically correct fashion to explain...

When you have completed the mapping, select the Save button arrow in the top right-hand area
of this screen.

NOTE: Other mapping screens in the system include mapping Course Outcomes in Outcomes
assessment as well as mapping Resource Allocation Requests to Program Goals. Visit the
MAPPING section of this manual for more information.

21
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RESOURCE ALLOCATION REQUESTS

[ RESOURCE ALLOCATION REQUESTS |

Begin entering Resource Allocation Requests (RARs) by selecting the RAR Form option in the
Resource Allocation Requests menu.

Resource Allocation Requests (RAR) ~
RAR Form
RAR Mapping (Required for Approval)

Unit RAR Dashboard

Select the green circle with the plus sign (+) & to add a new request.

Resource Allocation Requests (RAR) > RAR Form

Resource Allocation Request (RAR) o :
Request Type Was this item funded? Fiscal Year
View All ‘ v  ViewAl ‘ v ViewAll ‘ v

Use the form below to add a new Resource Requests. You will use this form for each Request. After saving this request and closing X
the form, you may add an additional request.

Instructional programs: All requests must be submitted for an academic cycle by the first Friday in June.

Administrative, Support, and Services areas: All requests for the next fiscal year must be submitted by November 30.

22
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Start by selecting the fiscal year for your request. Enter the fiscal year for which you are
requesting funding, not the current fiscal year.

Academic Affairs Program Sample

Resource Allocation Requests (RAR) > RAR Form

New Resource Allocation Request (RAR)

Santa Ana College

" RESOURCE ALLOCATION Education peser pimn
REQUEST (RAR) b

* denotes a required field

Fiscal Year* 2

Education Master Plan &

Requester's Name *

Requester's Department * P D F "
B

1601 Facility Modificatior

Item Description *

Request Type

L)
Is this a Facilities Improvement/Repairs Request? (If Yes, please contact the Director of Physical Plant/Facilities to review your P D F n

request.) () * -
v

_FMR Process_Final 6_1

How will you measure the success of this resource?

Will this request affect multiple departments and/or affect the entire campus?

Note the resources provided in the right pane. These resources are provided by the Budget
Office to assist you in aligning your requests with strategic priorities during mapping,
determining personnel costs, and handling Facility Modification Requests.

Enter your name, department and the description of your request. Next, select the appropriate
Request Type from the Request Type dropdown and continue down the form to complete the

rest of the fields.

23
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Note that additional information for some fields is available by selecting the information icon

© in the question. In some cases, the information box may open automatically and obscure
the field. Simply select the X icon from the top right corner of the box to close it.

Is this a Facilities Improvement/Repairs Request? (If Yes, please contact the Director of Physical Plant/Facilities to review your
|~

H
If determined a Facility Modification is required, complete the following steps:

Step 1 - Complete this RAR form for funding approval.

Step 2 - Follow and complete the standard operating procedures for Facility Modification Requests. SOPs and
v other Facilities Modification Request documents can be found in the right resource panel.

For assistance, please contact the Director of Budget & Accounting.

request.} *

Be sure to prioritize your requests with the ranking drop down. Work with your supervisor if you
are unsure how to prioritize your requests. You will be able to edit the form later if you need to
change your prioritization.

New Resource Allocation Request (RAR)
" RESOURCE ALLOCATION
REQUEST (RAR)
If Yes, please explain how this request affects multiple departments and/or the entire campus. @
Has this request been submitted to other funding sources? *
If Yes, what funding source (l.e., GF, Equity, SWP, Perkins)? @

If you are submitting multiple requests, please provide the ranking priority for this resource ()

| v
; Estimated Cost (Enter numbers only) (i)
|
Is this an annual on-going expense?
v
Budget Approval Follow-up (For Budget Office Use Only)
Was this item funded?
v

GL Account (digits xx 00X -XXXXXX - XXXXX -XXXX)

24
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Do not complete fields below the line that reads For Budget Office Use Only. The Budget Office
may complete these fields at a later date.

Note: Where you see an Asterisk (*) next to the name of a field, that field is required, and you will
not be able to Save the card until information has been entered into that field.

Once you have completed entering the RAR information, SAVE your work by selecting the Arrow
next to the SAVE button at the top of the screen. Notice that when you select the Arrow on the
SAVE button you are provided with the options to Save & Add New or Save & Close this RAR. If
you have additional RARs to add, select the Save & Add New option. If you have finished adding
RARs, select the Save & Close option.

Academic Affairs Program Sample
Resource Allocation Requests (RAR) > RAR Form

B Save & Add New

New Resource Allocation Request (RAR)

8 Ana €

= RESOURCE ALLOCATION ¢ Save&Close  pn™2
REQUEST (RAR) ! =)

After you have entered your requests, you will see a list of RARs on the screen. You may use the
filters at the top of the screen to show only particular requests, such as for a certain fiscal year.

You may also reorder a card by grabbing the card by the double-vertical ellipses ** handle and
dragging it to where you want it. You may also edit the card by using the ellipsis menu in the
right corner of the card to Openit.

25
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Resource Allocation Requests (RAR) > RAR Form ©)
Resource Allocation Request (RAR) o :
Request Type Was this item funded? Fiscal Year
View Al |v  viewal |~ | Viewau |v
Showing 2 of 2

2021 - 2022: Chemistry Faculty N. Support 6/15/22 E

Item Description
7 new burners for the chemistry lab are needed in order to allow students to perform required experiments.

Request Type
Conferences

Estimated Cost (Enter numbers only)
2,500

if 2022 - 2023: Faculty Member Name J. Steffens 10/4/22 %

Item Description
Teaching Assistant

Request Type
Personnel (Instructional)

Estimated Cost (Enter numbers only)
5,000

Other options in the card menu include Copy, Audit Log and Delete.

i 2021 - 2022: Chemistry Faculty N. Support 6/15/22|  /* Open

Item Description I_D Copy

7 new burners for the chemistry lab are needed in order to allow students to perform required experiments.

Request Type Audit Log
Conferences

Estimated Cost (Enter numbers only) ﬁ Delete
2,500

Once you have entered your requests, proceed to map your requests to your Program Goals by
selecting the RAR Mapping option from the menu.
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Visit the MAPPING section of this manual for more information.

Resource Allocation Requests (RAR) ~
RAR Form

RAR Mapping (Required for Approval)

Unit RAR Dashboard

RAR data can be viewed for your unit by selecting the Unit RAR Dashboard from the menu. Note
that this only shows data for this unit. Administrators can see RAR information across units by
using the dashboard in the Resource Allocation Request Overview unit. Visit the DASHBOARDS
section of this manual for more information.

Resource Allocation Request Overview

Home

' RAR Dashboard
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PROGRAM OUTCOMES ASSESSMENT

\ PROGRAM OUTCOMES ASSESSMENT |

The Program Outcomes Assessment screens are where you will enter your PLOs and Results
and your PLO Mapping:

Program Outcomes Assessment A~
PLOs and Resulis
PLO Mapping

The PLOs and Results screens include the following tabs/cards: Outcomes, Assessment
Method, and Results). To begin setting up the program assessment plan, you will first enter the

program outcome. Select the green circle with the plus (+) sign

Academic Affairs Program Sample

Program QOutcomes Assessment > PLOs and Results

Program Assessment o
PLO Status Program Assessment Cycle(s) Credential(s) Lol s
View Al |v  Viewal v ViewAll | v

Program Outcome Areas - HSS

View Al | v I

|

Once you have selected the green circle with the plus (+) sign o the following card will open.
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Academic Affairs Program Sample
Program Outcomes Assessment > PLOs and Results

New Program Learning Outcome (PLO)

= PROGRAM LEARNING :
{ ASSESSMENT METHODS RESULTS & ANALYSIS : ;

* denotes a required field.

PLO Name (i) *

nvas Analytics - Assignment

Program Learning Outcome (PLO) *

Nl P vy e b

PLO Status *

Program Assessment Cycle(s) *

f ‘ h nvas Analytics - Outcomes

Credential(s) *

Program Outcome Areas - HSS

Begin by entering the PLO Name*. Notice the Asterisk (*) next to the name of several of the fields.
The Asterisk (*) indicates that the field is required, and information must be entered for the
card/information to be saved. The Name should reflect the Outcome. For example: Critical
Thinking instead of PLO 1.

Notice the arrow icon next to some of the fields.
been provided from which you are to choose.

This icon indicates that options have

For the PLO Status, options will be Active or Archived. Select Active if this is a new Outcome
and you will be assessing this outcome. Archived may be chosen if this outcome will not be
assessed.

Qutcome Status *

Active

Archived
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Next, select the arrow and select the Program Assessment Cycles(s). This is the academic year
that this plan will be assessed. You may make multiple selections here.

Program Assessment Cycle(s) *

2023 - 2024 X | v ‘
2025 - 2026
2024 - 2025

2022 -2023

2021 -2022

Now, save your work by selecting the green Save button in the top right-hand corner of the card.
By selecting the Save button, without selecting the arrow, your work will be saved, and you can
continue working on the plan for this outcome.

By selecting the arrow, you will be offered the options to Save & Add New or Save & Close the
card. If you have other outcomes to enter, you may select Save & Add New and continue adding
outcomes. If you have finished adding outcomes, select the Save & Close option.

Close Save v

B Save & Add New

« Save & Close

If you select the Save & Close option, you will see a list of the PLOs that have been entered. In
the following example you can see that several Outcomes have been entered and saved. The
number of Outcomes is depicted in the top right-hand area of the screen:

Showing 2 of 2
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Program Qutcomes Assessment > PLOs and Results
~
Program Assessment o :
PLO Status Program Assessment Cycle(s) Credential(s)
View All ‘ v ViewAll ‘ v ViewAl ‘ v

Program Outcome Areas - HSS

View All ‘ v

Showing 2 of 2

i Anthropology: Analytic Skills N. Support 11/1/23

Program Learning Outcome (PLO)
Demonstrate strong skills in critical thinking, logical analysis, and analytical writing.

PLO Status

Active

Program Assessment Cycle(s)
2022 - 2023, 2024 - 2025
Credential(s)

AA

Program Qutcome Areas - HSS
Anthropology

it Sociology: Sample PLO 2 M. Support 11/1/23

Program Learning Outcome (PLO)

At the end of the program ...

PLO Status
Active

Program Assessment Cycle(s)
2023 -2024, 2024 - 2025
b

If you have selected the Save & Close option, have been returned to the screen above, and
would like to continue working on the assessment plans (entering Assessment Methods, and/or
Assessment Results & Analysis), select the ellipsis ~  to the right on the outcome card where
you would like to continue working.

Selecting the ellipsis will allow you to Open the outcome card, View/Print, or Delete the
outcome. Keep in mind that if you delete the outcome, you will also be deleting any results that

have been entered for that outcome.
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Now that you have entered the Program Learning Outcome, Select the ASSESSMENT METHODS
tab to enter an Assessment Method for that Outcome.

Program Outcomes Assessment > PLOs and Results

Q. Analytic Skills v

* PROGRAM LEARNING
ASSESSMENT METHODS RESULTS & ANALYSIS
OUTCOME (PLO)

* denotes a required field.

PLO Name (7) *
Analytic Skills

Program Learning Outcome (PLO) *

Demanstrate strong skills in critical thinking, logical analysis, and analytical writing.

PLO Status *

Active | v

Program Assessment Cycle(s) *

2022-2023 ® 2024-2025 x | hd
Credential(s) *
AA X | W

Program Outcome Areas - HSS

Anthropology | w

Once you have selected the ASSESSMENT METHODS tab you will see the following screen.

Program Outcomes Assessment > PLOs and Results

Q. Analytic Skills v
Assessment Method Status Assessment Type
View Al ‘ v  ViewAll ‘ v
Showing 2 of 2

PROGRAM LEARNING
® ASSESSMENT METHODS RESULTS & ANALYSIS [+
OUTCOME (PLO)

~
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To begin entering an Assessment Method select the green circle with the plus (+) sign. o

The following screen will open:

Program Outcomes Assessment > PLOs and Results

Analytic Skills

Program Outcome Areas - HSS: Anthropology Hide Details T

* denotes a required field.

Assessment Method Status *

Assessment Type (7) *

Method of Assessment *

Criterion/Target *

Notes

Related Documents

Document Mame Document Description o

There are no documents attached

Complete each field: Assessment Method Status, Assessment Type, Method of Assessment,
Criterion, and Notes.

Notice the arrow icon next to some of the fields.
been provided from which you are to choose.

This icon indicates that options have

For the Assessment Method Status, options may be Active or Inactive.

33




@ i SANTA ANA
(1] COLVLEGE

Assessment Method Status

Active

Inactive

Select Active if this is a new Outcome and you will be assessing this outcome. Inactive may be
chosen if this outcome will not be assessed.

Next, select the Assessment Type from the drop-down.
Program Outcome Areas - HSS: Anthropology Hide Details T
" denotes a required field.

Examples of "Media Production” include recordings, websites, artwork, etc. Use "Field Observation" for X
internships, student teaching, and other real-world experiences.

Assessment Type *

v
Exam/Quiz - In Course
Exam/Quiz - Standardized
Group Project
Individual Project
Media Production
Observation
Performance/Presentation

Portfolio Review

Survey o
W

Select the Assessment Type you plan to use for assessing this outcome.

Next, enter the Method of Assessment.
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Method of Assessment *

Criterion/Target *

Motes

Now, save your work by selecting the green Save button in the top right-hand corner of the card.
By selecting the Save button, without Selecting the arrow, your work will be saved, and you can
continue working on the plan for this outcome.

By selecting the arrow, you will be offered the options to Save & Add New or Save & Close the
card. If you have other assessment method to enter, you may select Save & Add New and
continue adding assessment methods. If you have finished adding assessment methods, select
the Save & Close option.

Close Save

B Save & Add New

« Save & Close

Once you have finished adding the assessment methods for each of the outcomes, and have
selected the Save & Close option, the following screen will appear showing the assessment
methods that have been entered.
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Program Outcomes Assessment > PLOs and Results

Q, Analytic Skills v

Assessment Method Status Assessment Type
View Al |~ Viewal |~

Showing 2 of 2

PROGRAM LEARNING
® ASSESSMENT METHODS RESULTS & ANALYSIS °
OUTCOME (PLO)

it Term Paper C. Brocatto 6/28/23 :

Assessment Type
Exam/Quiz - In Course

Method of Assessment
Term Paper

Criterion/Target
Departmental scale employed for assessment of student work:

(1) Emergent Understanding

(2) Developmental Understanding
(3) Proficiency

(4) Mastery

80% of students achieved target on departmental assessment scale.

it Written essay ... C. Brocatto 6/28/23 :

Assessment Type
Written Assignment

Method of Assessment
Written essay ...

Criterion/Target

When you have completed adding assessment methods, you may continue to the Results &
Analysis tab.
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PROGRAM ASSESSMENT RESULTS & ANALYSIS

To enter the assessment results, and the analysis of those results, select the RESULTS &
ANALYSIS tab.

Program Outcomes Assessment > PLOs and Results

Q. Analytic Skills | ~
Assessment Method Status Assessment Type Criterion/Target Met
View All ‘ v  ViewAll v ViewAll ‘ v
Program Assessment Cycle
View All |~
Showing 3 of 3
PROGRAM LEARNING ASSESSMENT METHODS ® RESULTS & ANALYSIS
OUTCOME (PLO)
Term Paper o

If a new Result and Analysis is being added for an assessment method, select the green circle
with the plus (+) sign L

Once you select the green circle with the plus (+) sign the following information will appear
allowing you to choose the assessment methods that have been previously entered for

assessment.

Now, select the assessment method where you would like to enter the results and analysis. For
this example, Term Paper has been selected. The following card will open.
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Program Outcomes Assessment » PLOs and Results

Analytic Skills

Pr?t_gram Learning Outcome (PLO): Demonstrate strong skills in critical thinking, logical analysis, and analytical Hide Details T
writing.

PLO Status: Active

Program Assessment Cycle(s): 2022 - 2023, 2024 - 2025

Credential(s): AA

Program Outcome Areas - HSS: Anthropology

Assessment Type: Exam/Quiz-In Course

Method of Assessment: Term Paper

Criterion/Target: Departmental scale employed for assessment of student worl:
(1) Emergent Understanding

(2) Developmental Understanding

(

(

3) Proficiency
4) Mastery

80% of students achieved target on departmental assessment scale.

Results & Analysis Date *
04/26/2024

Program Assessment Cycle *

Results & Analysis *

Criterion/Target Met

Action Plan for Improvement

Related Documents .

This view of the card will allow you to see the entire plan information. If you would like to hide the

Hide Details T
plan information, select the Hide Details icon to the right.

Note: Hiding the plan information is temporary and can be undone by selecting

Show Details 1
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If you have hidden the plan information the card will look like the following:

Academic Affairs Program Sample

Program Outcomes Assessment > PLOs and Results

Analytic Skills

Show Details 4

* denotes a required field.
Results & Analysis Date *
04/26/2024

Program Assessment Cycle *

Results & Analysis *

Criterion/Target Met

Action Plan for Improvement

Related Documents

Document Mame Document Description o

There are no documents attached

Now, enter the results and analysis. The first entry will be the Results & Analysis Date. Notice the
Asterisk (*) next to the name of the field. Note: wherever you see the Asterisk (*) the information
is required, and you will not be able to Save the form until this information has been entered.

Continue this process of entering information through to the last field. The last field, Related
Documents, will allow you to select documents from the Document Library/Repository and attach
them to the results report.
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Related Documents

Document Mame Document Description o

There are no documents attached

To add an item from the Document Library/Repository, begin by selecting the green circle with
the plus (+) sign. °

The following screen will open and allow you to select a folder.

Document Repository

#

(| Academic Affairs Program Sample

Select a folder where you have stored the file by selecting the folder. The folder will open and
allow you to select a file.

Locate the file that you would like to include in your results/analysis. You may select more than
one file by selecting the check box next to each file.

Document Repository O X

ﬁ > ACADEMIC AFFAIRS PROGRAM SAMPLE

(| General

Once you have selected the file(s) that you would like to include, select the Attach icon in the
top right side of the card. Notice that the Attach icon turns yellow.
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Program - Psychology (New Plan Types)

Document Relate Repository O X

ﬁ > PROGRAM - PSYCHOLOGY (NEW PLAN TYPES) > GENERAL

D D coming-soon-v2.png

@ Sample Outcome Evidence.docx

Note: If the file you want to include in your results is not among the files listed, you can add a
file to the library/repository by selecting the file + icon to the right on the Attach icon.

ATTACH [ [ X

Selecting this icon will allow you to select a file from your computer.

Once you have selected the icon, the following dialog box will open. Select the Choose Files
button and select a file from your computer.

Add Document(s) to General

Choose Files | No file chosen

CANCEL X
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The file will now appear in the dialog box. Now select Save to upload the file.

Add Document(s) to General

Choose Files | Program R_..ponses-1.xls

Name *
Program Review Narrative Responses-1.xls

Description

CANCEL X  SAavER)

The file will now appear in the list of files and is ready for you to attach to your results/analysis.

Program - Psychology (New Plan Types)

Document Relate Repository ATTACH O X

ﬁ > PROGRAM - PSYCHOLOGY (NEW PLANTYPES) > GENERAL

|:| D coming-saon-v2.png

D Program Review Marrative Responses-1.xls

@ Sample Outcome Evidence.docx

Again, once you have selected the file(s) that you would like to include, select the Attach icon in
the top right-side of the card. Notice that the Attach icon turns yellow.
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Document Relate Repository O X

ﬁ > PROGRAM - PSYCHOLOGY (NEW PLANTYPES) » GENERAL

D D coming-soon-v2.png
D Program Review Narrative Responses-1.xls

@ Sample Outcome Evidence.docx

The files are now attached to the results/analysis for this assessment method.

Supporting Documents

Document Name Document Description °
Program Review Marrative Responses-1.xls x
Sample Outcome Evidence.docx >

The RESULTS tab is now complete.

Save your work by selecting the green Save button in the top right-hand corner of the card. By
selecting the Save button, without selecting the arrow, your work will be saved, and you can
continue working on the plan for this outcome.

By selecting the arrow, you will be offered the options to Save & Add New or Save & Close the
card. If you have other assessment method to enter, you may select Save & Add New and
continue adding assessment methods. If you have finished adding assessment methods, select
the Save & Close option.

B Save & Add New

« Save & Close ‘

Finally, map your PLOs. See the MAPPING section of this document for more information.
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COURSE OUTCOMES ASSESSMENT

‘ COURSE OUTCOMES ASSESSMENT |

If you have been granted the correct permissions, you will see the Course Assessment menu
heading in the Main Menu. Select the Menu heading to expand the menu:

Course Outcomes Assessment W

Course 5L0s and Results

SLO Mapping

Selecting Course SLOs and Results will show the following screen:

Academic Affairs Program Sample

Course Outcomes Assessment > Course SLOs and Results

Select a Course: Sample 100. Introduction to Assessment |V o

Course SLO Status
View Al | v

To begin, select the course from the drop-down, for which Student Learning Outcomes (SLOs)
will be entered.
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Program - Psychology (New Plan Types)

COURSE ASSESSMENT > Course Assessment

PSY-235. Developmental Psychology | v e
PSY-112. Addictions and Recoveries - Shawing
3 PSY-205. Business and Industrial Psychology* Dof0

PSY-209. Behavior Modification*

PSY-212. Psychological Experimentation*
entered. Please click the add button ° to create a/n Student Learning Outcome

PSY-215. Advanced Experimental Psychology

PSY-220. Introduction to Human Services

PSY-225. Introduction to Statistics for Social Sciences
PSY-230. Statistics and Methodology in the Behavioral Sciences

PSY-235. Developmental Psychology |

Once the course has been selected, select the green circle with the plus sign (+) @

in the center of the card, or in the top right-hand corner of the card. The following card will open.

Academic Affairs Program Sample

Course Outcomes Assessment > Course SLOs and Results

New Course SLO
Muventve
® COURSE SLO METHOD OF ASSESSMENT RESULTS e -
* denotes a required field. .l 1
Course SLO Name (i) * I
nvas Analytics -
Course SLO *
Nivenllve, i vaiber vl
Course SLO Status j e
Implementation Date (i) g ——
nvas Analytics -
Inactive Date
Identifier ()

Begin by entering the Student Learning Outcome (SLO) Name. It is recommended that you refrain
from using only SLO 1, SLO 2, etc. to avoid confusion if/when SLOs will be archived. Instead,
provide a unique name that represents the Student Learning Outcome in the next field. For
Example: SLO 1 - Logic of the Scientific Method. Notice the Asterisk (*) next to the field name:
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SLO Name *. Anytime you see an Asterisk (*), the field is required, and you will not be able to save
your work until this field is completed.

Next, enter the Course SLO. Example: students will be able to identify key elements of the
scientific method as applied to mental processes and behavior.

Then, select the SLO Status from the drop-down. The choices are: Active or Inactive. Active means
the SLO is being assessed. Inactive means that the SLO has been taken out of use. NOTE: Once
results have been entered for an SLO do NOT delete the SLO. If the SLO is deleted ALL results
that have been entered for that SLO will also be deleted.

Course SL0O Status

]

Active

Inactive

IMACTIVE 1THIE

Complete the remaining fields. The data entered should match your curriculum management
system.

Once you have completed entering the SLO information, SAVE your work by selecting the SAVE
button in the top right-hand corner of the card. Notice that the SAVE button also has an Arrow
next to the word “Save.” If you select the word “Save” you will have saved the work and can
continue to the METHOD OF ASSESSMENT tab, or RESULTS tab.

If you select the Arrow on the SAVE button, you are provided with the options to Save & Add New
or Save & Close this SLO. If you have additional SLOs to add, select Save & Add New. If you have
finished adding SLOs and would like to return to the main Course Assessment Screen, select the

B Save & Add New

« Save & Close

Save & Close option.

Save and Close will take you back to the main Course Assessment Screen where you will see all
SLOs that have been entered.
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Academic Affairs Program Sample

Course Outcomes Assessment > Course SLOs and Results

Select a Course: Sample 100. Introduction to Assessment | v o
Course SLO Status
View All ~
Showing 1 of 1
it Sample SLO 1 N. Support 4/26/23

Course SLO
Students will learn ...

Course SLO Status
Active

Save and Add New will provide a new card for you to continue adding SLOs. Notice that in the
upper right-hand side of the card above, under the green circle with the plus sign (+), you see 1
of 1. This is an indicator of the number of Student Learning Outcomes (SLOs) that have been
entered. Once you open the Outcome, this same indicator will allow you to see which Outcome
you are currently viewing and working on.

The next step in the planning process is to add the Assessment Method for each SLO. From the
main Course Assessment Screen, select the SLO where you would like to enter the Assessment

Method, by selecting the vertical ellipsis to the right of the SLO card. *

# Open
= View/Print

O Delete
The following dialog box will appear.

Open will open the SLO card.

View/Print will allow you save the information to your computer for printing. Delete will delete
the SLO, and all information connected to that SLO, including any results that have been
entered.

Now, select Open. You will now see the SLO information that was previously entered.
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Academic Affairs Program Sample

Course Outcomes Assessment » Course SLOs and Results

Q, Sample 100 - Sample SLO 1 | v

" COURSE SLO METHOD OF ASSESSMENT RESULTS

* denotes a required field.

Course SLO Name () *

Sample SLO 1

Course SLO*

Students will learn ...

Course SLO Status
Active v

Implementation Date ()
04/26/2023

Inactive Date

Identifier (i)
OO

Next, select the METHOD OF ASSESSMENT tab.

Academic Affairs Program Sample

Course Outcomes Assessment » Course SLOs and Results

Q, Sample 100 - Sample SLO 1 | v

Showing T of 1

COURSE SLO ® METHOD OF ASSESSMENT RESULTS o

To begin entering the assessment method for this SLO, select the green circle with the plus (+)
sign in the top right-hand corner. &

The following card will open.

48




@ _© SANTA ANA

|
MMl |ICOLLEGE

Academic Affairs Program Sample

Course Outcomes Assessment > Course SLOs and Results

Sample 100 - Sample SLO 1

Muventve

* denotes a required field

f

|
|

Status v
| v I
_—#
Assessment Type .
nvas Analytics - Assignmen
| v
Method of Assessment* Mavantl

Criterion/Target o

nvas Analytics - Outcomes

Notes

Notice the four icons in the top right that split the window. Selecting one to open the right pane
will provide access to dashboards containing Canvas data for the course.

Now, select the arrow to the right of the Status field. This will allow you to select from the options
provided.

* denofes & required field.

Status

]

Active

Inactive
WIELNOO O ASSESSIment =
If this is a new SLO, and you plan to assess this SLO, select Active. Inactive means that the SLO
will not be assessed and will be hidden from this page.

Next, select the Assessment Type. You can only select 1 Assessment Type. If you plan to Assess
this SLO by additional Assessment Methods, you will be provided with that option when you are
ready to SAVE this card.
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Exam/Quiz - Standardized
Group Project

Individual Project

Media Production
Observation
Performance/Presentation
Portfolio Review

Survey

Written Assignment

I*:I

In the next field, Method of Assessment, describe how you plan to assess this SLO.

Academic Affairs Program Sample

Course Outcomes Assessment > Course SLOs and Results

Sample 100 - Sample SLO 1

Muventve i grr Gy Prina: Pl
* denotes a required field.
Status o T
Active | v I
——— |
Assessment Type N .
nvas Analytics - Assignmeni

Exam/Quiz - In Course

Method of Assessment*

Students will be assessed using Quiz #3 ...

Nl Chi Vit e e

Criterion/Target
75% of students will score 75/100

Notes

WM o

nvas Analytics - Outcomes
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Next, provide the success Criterion. This will be the Target level of achievement for the group
being assessed. Continue entering information for the remainder of the fields for this Method.

You have now completed the METHOD OF ASSESSMENT for that SLO. Remember to SAVE
your work! You may continue adding assessment methods for each of the SLOs, or you may
Save and Close to return to the main COURSE OUTCOMES ASSESSMENT screen.

COURSE ASSESSMENT RESULTS

To begin entering the RESULTS for a Course Student Leaning Outcome (CSLO), locate the SLO
where you would like to enter the results. Open the card by selecting the ellipsis to the right of
the SLO card.

Academic Affairs Program Sample

Course Outcomes Assessment > Course SLOs and Results

Select a Course: Sample 100. Introduction to Assessment | v o
Course SLO Status Nuwn.tvls
View All v —ee—
Showing 1 of 1 EE
i Sample SLO1 N Support 4/26/23 & I R

nvas Analytics - Assignment

Course SLO
Students will learn ...

Course SLO Status
Active

Once you have selected the ellipsis, the following menu will appear. Now, select Open.
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Academic Affairs Program Sample

Course Outcomes Assessment > Course SLOs and Results

Selecta Course: Sample 100. Introduction to Assessment | v o :
Course SLO Status Nlmf"! M i iy "-'_"‘ =
View All v 7
ik
Showing 1 of 1 '
it Sample SLO 1 N. Support 4/26/23|  #° Open el
men
Course SLO |— Co | 1
Students will learn ... D Py
Course SLO Status Audit Log
Active
) | = [ —%
O Delete | =]

That specific STUDENT LEARNING OUTCOME screen will open — as seen below.

Academic Affairs Program Sample

Course Outcomes Assessment > Course SLOs and Results

Q, Sample 100 - Sample SLO 1 | v
Fm PR
METHOD OF ASSESSMENT RESULTS ;
* denotes a required field. . -l
Course SLO Name () * I
Sample SLO 1 il
nvas Analytics - Assignmer
Course 5LO *
Students will learn ... sy v s
Course SLO Status

Active v ( u ) SR

Implementation Date (7) wlwl e
04/26/2023 nvas Analytics - Outcomes
Inactive Date
Identifier (i)
OO0

Next, select the RESULTS tab. The following screen will open.

52




€1 SANTA ANA

|
il ICOLLEGE

Academic Affairs Program Sample

Course Outcomes Assessment > Course SLOs and Results

Q, sample 100 - Sample SLO 1

Showing 0 of 0

COURSE SLO METHOD OF ASSESSMENT ® RESULTS I EEN—— |
nvas Analytics - Assignmen

Exam/Quiz - In Course

Muvalive, Chers by ol b

Mo Results has/have been entered

If a new Result is being added for an assessment method, select the green circle with the plus
(+) sign ©

The following screen will open. This view of the card will allow you to see the entire SLO
information. If you would like to hide this information, select the Hide icon to the right.

Hide Details T

Note: Hiding the CSLO information is temporary and can be undone by selecting

Show Details 1
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Course Outcomes Assessment > Course 5L0s and Results

Save v =

Sample 100 - Sample SLO 1

Muventve
Course SLO: Students will learn ... Hide Details T L
Course SLO Status: Active

Method of Assessment: Students will be assessed using Quiz #3 ...

*denotes a required field I
Results & Analysis Date *
nvas Analytics - Assignmeni
Semester of Assessment *

Nl S by i e

Results & Analysis *

Criteri t Met * i t
riterion/Target Mef nvas Analytics - Outcomes

Actions

Action Date

Action

Now, enter the Results. The first entry will be the Results & Analysis Date *. Notice the Asterisk

(*) next to the name of the field. Note: wherever you see the Asterisk (*) the information is

required, and you will not be able to Save the information until this information has been entered.
A

Also, notice that there is an arrow to the right of the Semester of Assessment field.

Selecting any arrow will open a drop-down where you will select from the choices provided. See
example below.

54




Semester of Assessment *

@ _© SANTA ANA

2024 - 2025 (Spring 2025)
2024 - 2025 (Fall 2024)
2023 - 2024 (Spring 2024)
2023 - 2024 (Fall 2023)

\€ 2022 - 2023 (Spring 2023)

2022 - 2023 (Fall 2022)

Continue working down the card.

You have now completed the ASSESSMENT RESULTS. Be sure to proceed with mapping your

]

SLOs by selecting the SLO Mapping option in the main left navigation menu:

Course Outcomes Assessment

Course SLOs and Results

SLO Mapping

e

I‘\
Il ICOLLEGE
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MAPPING

| MAPPING |

There are many mapping options in Nuventive. You can map Program Goals to Resource
Allocation Requests, SLOs to PLOs, SLOs to ILOs, PLOs to ILOs, and much more. Look for a
mapping option in the menu under each major menu heading. All mapping, conducted within the
mapping screens (Curriculum Mapping, Goals Mapping, Outcomes Mapping, etc.) function the
same. The only differences are that: 1. You will select the type of mapping from the drop-down,
2. The rows and columns of the mapping table may change.

Here’s an example of mapping Course Outcomes to Program Outcomes:

Course Outcomes Assessment > SLO Mapping

Selecta Course:  Sample 100 Introduction to Assessment | hd

To map/align a course SLO to a PLO, ILO, etc., click in the cell where the two line up and turn it green. Be sur

If the text of any objective is truncated, simply hover over the three dots at the end of the text shown on the

Course Assessment
X=X

Program Assessment v Sample SLO 1
Students will learn ...

Analytic Skills
Demonstrate strong skills in critical thinking,
logical analysis, and analytical writing.

Sample PLO 2
At the end of the program ... , |

The green tile with the letter x indicates that this column and row are mapped together.
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CURRICULUM MAPPING

In the PLO Mapping screen, you can select Curriculum Mapping from the drop-down
to the left of the screen as depicted below.

Program Outcomes Assessment > PLO Mapping

PLO Status Program Assessment Cycle(s) Credential(s) Program Outcome Ar
View all W View All w WView All w View All

Ta |11:a|'|.-'u||-:_|" a PLO to an ILO, efc., click in the cell where the two line up and turn it groen Be sure 1o click save at the top right before exiting the Scoed

If the text of any objective is truncated, simply hover over the three dots at the end of the text shown on the screen and the full text will pop up

Program Assessment Ad
1= Infroguced, B = Remforced, M = Mastanad
EPSLO 1 EPSLO 2
Students will be able to modify the nursing Students will be able to select theories
Outcomes (ILOS) process to meet the patient’s biological and rel_ated to natural, behavioral, and social _
psychosocial system needs, which are sciences that influence a patient’s biological

influenced by the interaction of the physica and psychosocial system needs in order 1o

SAC Educational Master Plan
20:21-2024 - SAC Educational

| Master Plan

| R M I R M
' Curriculum Mapping

| R L I R M
Topics
NRN-105 . i R M [ R M
Cooperative Work Experience-Occupational
NRN-1064
Health Science Skills Laboratory- First | R M I R M
Semester

Next, notice that the courses aligned to this program are listed in the left-hand column.
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Academic Affairs - Nursing

Program Outcomes Assessment > PLO

PLO Status Program
View All ~ View £

To map/align a PLO to an ILO, etc., click in the ce

If the text of any objective is truncated, simply hc

Curriculum Mapping b

NCE-145
Advanced Cardiac Life Support

NRN-098
Topics

NRN-105
Cooperative Work Experience-Occupational

NRN-106A
Health Science Skills Laboratory- First
Semester

NRN-106B
Health Science Skills Laboratory- Second
Semester

NRN-106C
Health Science Skills Laboratory- First Year
Refresher

To the right each course is the Program Learning Outcomes (PLOs) for this program. These are
the PLOs that have been entered for the Program Assessment Plan.
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Program Learning Assessment :

| I - Introduced, R - Reinforced, M - Mastered ke
Critical Thinking Application Communication Research

R M I R M I R M I R M

| R M I R M I R M I R M
| | | | | | |

R M I R M I R M I R M

I R M I R M I R M I R M

sl | I s | | [ f I |
R M I R M I R M I R M
| R M I R M I R M I R M

Indicators have been provided: I - Introduced, R - Reinforced, M - Mastered.

Program - Psychology (New Plan Types)

X
. ; Program Learning Assessment H
Gitchinanping I - Introduced, R - Reinforced, M - Mastered B -
Q, se v Ke Critical Thinking Application Communication Research
PSY-100
General Psychology 1 R M 1 R M I R M I R M
PSY-112
Addictions and Recoveries 1 R M 1 R M I R M | R M
IR I | S | | 1 | | 1 |
PSY-205 [ [ |
Business and Industrial Psychology ! R M R M I R M I R M
PSY-209
Behavior Modification ! R M 1 R M 1 R M I R M
| | | | | | | | | | | | |
PSY-212 |
Psychological Experimentation I R M R M I R M I R M
PSY-215 [ 1 1 - d T : .
Advanced Experimental Psychology 1 R M I R M I R M I R M
| | | | | |
PSY-220 _ B ) B ] B ] ] -
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By selecting the appropriate indicator under each PLO and aligned to the course(s) on the left,
select where this PLO will be Introduced, Reinforced, of Mastered. Use the scroll bars at the
bottom, and to the right, to move across the screen to reveal all courses and/or PLOs). If you
would like to remove any mapping you have selected, select the highlighted indicator again to

unselect. Once you have completed the mapping, the SAVE button, in the top right-hand
corner, will illuminate and you will be able to save your mapping work.

Another feature offered in the mapping screens is the option to add notes. Notice the icons to

Add Note &
the right, just below the Save button.

By selecting Add Note, the following dialog box will open.

Program Learning Assessment Mapping Note

9 Hours of Humanities Electives choosen from: HUM-201, HUM-302, HUM-311, REL-102, REL-210

6 Hours of Math Electives choosen from: MATH-210, MATH-211, STAT-101

This is where you can add notes relevant to your mapping work. To add notes, Select within the
dialog box. The dialog box nhow changes to a text box with options like that of a Word document.
You will now be able to customize the font, add a table, include a picture or graphic, and/or link
(URL) to an external document, and/or locate and include a document in your Document
Library/Repository.

Program Learning Assessment Mapping Note Close Save

-+~ MNormal ~-| B I U  A-~ 1 - =@ M e &

|9 Hours of Humanities Electives choosen from: HUM-201, HUM-302, HUM-311, REL-102, REL-210
6 Hours of Math Electives choosen from: MATH-210, MATH-211, STAT-101
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Once you have completed adding the Note, Select the SAVE button at the top of the card. Once

Close Save
you have saved the Note, and have completed adding notes, select Close.

RAR MAPPING

To complete the required mapping to goals for Resource Allocation Requests (RARs), select the
option for mapping in the RAR menu. You must have already entered program goals under the
Program Review menu and complete the RAR form before selecting.

Program Review v
Resource Allocation Requests (RAR) ~
RAR Form

RAR Mapping (Required for Approval)

Academic Affairs Program Sample

Resource Allocation Requests (RAR) > RAR Mapping (Required for Approval)

Request Type Was this item funded? Fiscal Year
View All | v ViewAll v Viewal

To map your RAR to a Program Goal, click the X to turn it yellow and click "Save” in the top right. To remove a mapping relationship, simply uncheck to rem
yellow color.

If text is truncated, please hover over the three dots and the full text will appear.

Resource Allocation Request (RAR)
X=X

Program Review Goals R 7 new burners for the chemistry lab Teaching Assistant
are needed in order to allow students...

Chemistry Lab

Upgrade the equipment in the chemistry lab
as well as revise curriculum to address
latest chemistry lab techniques.

ZTC / OER
Create additional resources. I |

Improve Support
Additional tutoring

Next, notice that the program goals are listed in the left-hand column.

Selecting the appropriate indicator under each RAR aligned to the Goal(s) on the left If you
would like to remove any mapping you have selected, select the selected indicator again to

unselect. Once you have completed the mapping, the SAVE button, ﬂ in the top right-hand
corner, will illuminate and you will be able to save your mapping work.
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REPORTS

Word reports can be generated using the options in the main navigation menu.

Note the date and time that the report was generated in the top right next to the Refresh button.
The system caches reports so the report may not reflect the most recent data. Select the
Refresh button to ensure the report contains the most recent data.

Academic Affairs - Engineering . .

Reports > Annual Program Review & RAR Report - All Years Report last run 7/22/20252:57PM | REFRESH DOWNLOAD AS ZIP

= ONLYOFFICE File  View ANNUAL PROGRAM REVIEW & RAR REPORT g + Q @
Q
®

ANNUAL PROGRAM REVIEW
& RAR REPORT

Academic Affairs - Engineering

Open the file menu to see additional options for working with the report document. You can
Download, Print, view Info or adjust Advanced Settings in this menu.
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Academic Affairs - Engineering . .

Reports > Annual Program Review & RAR Report - All Years Report last run 7/22/2025 2:57PM | REFRESH DOWNLOAD AS ZIP

* ONLYOFFICE View ANNUAL PROGRAM REVIEW & RAR REPORT = 4 Q @
< Back

Download As

ok Download As

CSI Print
@ Info
=fuu]--
TXT FB2 EPUB HTML
A
H Advanced Settings JPG

Some reports offer the option to filter the data that they contain. By default, many reports
include data from every year of entry. To filter information in the report, use one of the split
window buttons in the top right to open the right pane and select the report icon.

Academic Affairs - Engineering | v g

Allludl FTugidalil - Report last run UUWNLUAD
Reports >  Review & RAl 8/11/2025 REFRESH
U-09 A

A o

# ONLYOFFICE File > AN .. & L a @

| e
Select Icon
for Filters

1

Report Instructions

jo}

©

SANTA ANA
COLLEGE

ANNUAL PROGRAM
REVIEW REPORT

Ah Program Samps

Annual Program Review Report - ...

ANNUAL PROG

© DAD DEDNDT
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By selecting the report icon, filters will open.

AU FILQIdill Heport kast run LU W
Reports >  Review &RAR 8112025 REFRESH o B O

= OHIYOFFICE e > AM .. — T s ﬂ

Anmusall Prograsm Review Report Dpticns

Annigal Program Review Year
Wiew All

Pragram Rewlew Dol Repert Optlone

B B
®2f SAN ==
il co1

Yiew Adl

EEERENR
Resource Allocatien Request Report Options

ANNUAL PROG e

Q DAD DEDNDA

Make your choices and select the Run Report button to generate the custom version of the
report. The report will be presented side-by-side with the original version of the report.
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osemic Aflars - Enginecring | v m

Allliudl Fiogidiii Report last run DUWNLUAD .
Reports > Rewew&RARReport 8{11.’20251018REFRESH Reportlestrun8/11/202510:18am <> B, @ = X
= ONLYOFFICE File  View  ANNUAL .. 8 4L a 0@ = ONLYOFFICE File  View  ANNUAL .. 5 L a @
Q Q
® ®

I I

\ SANTA AN \! SANTA ANA
! ICOLLEG Ill COLLEGE

ANNUAL PROGRAM REVII ANNUAL PROGRAM REVIEW
& RAR REPORT REPORT

Academic Affairs - Engineering Academic Affairs - Engineering

Page10f24 7 Word count 0 1 — zoom70% +

Page 10f26 - Word count D _’__| — ZoomT70% -+

The Capstone Program Review report is similar to the Annual Program Review and RAR Report
except that it excludes RARs by default. To include RARs in the Capstone Program Review
Report, open the right content pane, select the fiscal year(s) of the RARs to include, and run the

report.

Academic Affairs - Engineering ‘ ~

Report last run DUWNLUA
R i) 1172025 10:19  REFRESH Reportlestrun8/11/202510:19aM <> B, @ = X

e 2 Review Report

== ONLYOFFICE File  View CAPSTONE .. 2 1 Q @
Report Settings RUN REPORT

Q
= Select Goal Filter(s) Below
@ I
Goal Status
1 i v
@ SANTA ANA v |
' ' ' C O L L E G I Reporting Period
I —— View All | v
CAPSTO N E P RO G RAM Select Capstone Program Review Cycle(s) Below
REVI EW RE PO RT Capstone Program Review Cycle(s)
View All v
Academic Affairs - Engineering Select Resource Allocation Request Fiscal Year(s) Below
Page1of5 7= Word count 0 M — zZoom70% +
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DASHBOARDS

Some units and screens have dashboards that display information. As with other reports, the
data that is presented is not live data. Unlike Word reports, dashboards are refreshed
automatically on a scheduled basis and cannot be manually refreshed. Be sure to look for the
“Last Updated” timestamp on each dashboard.

= Resource A‘location RequeSt Ovemiew | - m

& Nuventive.Improve Analytics  Resource Allocation Requests

Fiscal Year Request Type Fadlities Improvement Regquest? Is this an annusl on-geing sxpense? Parent Urit

Estimated Cost by Request Type MNumb er of Requests by Request Type

Budiget Augmentston

Faciities |mpronements/Repars

Persanng [Non-instructional} \ 32031 27 3523 ;3 ;g ¥ ¥ n o g 7
’ e s i - - - - e e — _' 1
Personne! (Instructons) &t R » -
o qﬁ“i\é&o @agé' Q“é\ @lﬁ r_)?@ 6@6 .d’:s' £ Log&a \lé\gp <5

Fiscal Year Estimated Cost Requester's Mame Requester's Department Item Dres cription

Data that is displayed on a dashboard can be exported by hovering over it until the data menu
appears to the side.
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Semester of Assessment

All s

More options

& @ = B -
Program Active SLOs éctive SLOs Assessed Active SLOs Assessed (%)
Academic Affairs - Nursing 89 63 70.8%

NRN-170 7 A [

NRN-171 7 F N [

MRMN-171L 7 T 1000%

NRN-172 7 7 _

Select the ellipsis to open a menu of more options that includes Export data.

Export data

o)

Show as atable
Spotlight
Getinsights

o 2 @

—

Sort descending

HE =R

i

Sort ascending
Sort by >

The dashboards in Nuventive are Power Bl dashboards. The options that are available on each
dashboard will vary but, in some cases, you will be able to drill down onto a data point and take
other actions that you are used to taking when interacting with a Power Bl dashboard. For
example, you may sort a table by clicking on the column heading or drill down onto a data point
by clicking on a portion of a chart.

Filters on the dashboards will only display options for which there is existing data. This
characteristic is seen most often when using multiple filters together. Compare the unit filters
below. When no fiscal-year filter is applied, all units are shown (left). When a filter for fiscal year
2025-2026 is applied, only the units with existing data are shown (right).

67



https://learn.microsoft.com/en-us/power-bi/fundamentals/power-bi-overview

Ty|

Parent Unit

All Academic Affairs Units

All Academic Support Services Units
All Administrative Service s Units

All Continuing Education Units

All Student Services Units

Division - Business

D - FPA
Di - HS&T
Di - H35

- Kinesiology
Division - SCE Departments

T Ty

-"\
]
il

Parent Unit
All

o |
All Academic Affairs Units
Division - Business

' SANTA ANA
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DOCUMENT LIBRARY

[ DOCUMENT LIBRARY |

The Document Library is where a variety of documents and files can be uploaded and stored for
use within the Nuventive Improvement Platform. To find the Document Library, first select the

Main Menu icon E to reveal the Main Menu. The Document Library will be the menu option at
the bottom.

To add a folder to your Document Library, select the Add Folder icon in the top right.

Document Library Add Folder

Home > President's Office - Student Information Support (|

[0 O 2022-2023

[ O General

To move folders(s), first select the item(s) and the use the ellipsis menu in the top right to
open a dialog box and select a destination.

Document Library
Home > President’s Office - Student Information Support Move Selected Items
O O 20222023

[0 O General

Other options for working with the folders are available using the ellipsis * menu next to each
folder.
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Document Library

Home > President's Office - Student Information Suf

[J O 20222023 4  Rename

[ O General «  Share

[m] Delete

Once you have drilled down into a particular folder, a button will appear for you to add
documents to the folder.

Document Library

Home > President's Office - Student Information Support > General ()

O @ Workload Trend.xlsx

The button will open a dialog box that allows you to upload a document. Select the browse
button to locate the document on your computer.

Add Document(s) to General

| Browse... | No files selected.

Urls

Name url Description

* denotes a required freld.

CANCEL X

You can also upload a new version of a file that you previously uploaded by selecting the ellipsis
menu next to the file and selecting Edit.
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Document Library

Home = President's Office - Student Information Support = General

O @ Workload Trend.xlsx ¥  Open

oy Download

B  CopyURL
v Edit
O Delete

Select the Browse button in the dialog box to upload the new file.

Edit Document

Display Mame

Workload Trend.xlsx

Description

System Support Increase Over Time

Last Modified: 11/10/2022

I | Browse. .. | No file selected. I

CANCEL X  SAVER
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USER ASSIGNMENT AND ROLES

USER ASSIGNMENT AND ROLES

Your view in Nuventive will vary depending on the roles that have been assigned to you for your
units. Some users can change the access users have to their unit(s). Users with that ability will
see a menu option labeled Assign Users in the main menu. To see this option, you must have
the Unit Management role for the unit.

Assign Users

The Assign Users menu will list the unit that you are currently in on the left, with assignable
roles in a dropdown on the right.

E Academic Affairs Program Sample | v m

Assign Role By Unit

Unit Role
Academic Affairs Program Sample | v

SLO Assessment
Search Program Review and RAR
A Edit All
Abbey, Troy  Abbey_Troy@sac.edu

Abdelmuti, Ashraf  Abdelmuti_Ashraf@sac.edu Reports Only
Abi-Fadel, Vina Abi-Fadel_Vina@sac.edu

Ahrahame | swranca Ahrahame | swrancafoar adn

Unit Management
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Each role provides a different level of access to the unit:

e Edit All - User can see every menu option except for Assign Users. User has full edit
access to forms and reports for the unit.

e SLO Assessment — Like Edit All, but only for the Outcomes menu options. No access to
Program Review, RAR or Assign Users.

e Program Review and RAR - Like Edit All, but only for Program Review and RAR menu
options. No access to options for Assessment and Assign Users.

e Reports Only — Cannot edit anything in the unit, but has access to every report.

e Unit Management — Same as Edit All, but includes the Assign Users menu option.

The Assign Users screen is split between users that do not have an assigned permission to the
unit on the left, and the users that have a current role assigned with the unit on the right.

Unit Role
Academic Affairs Program Sample

Abbey, Troy  Abbey_Troy@sac.edu . Andom, Eden  (Program Review and RAR)  Andom_Eden@ :
Abdelmuti, Ashraf  Abdelmuti_Ashraf@sac.edu Beyersdorf, Mafthew  (Edit All)  Beyersdorf_Matthew@sac.e
Abi-Fadel, Vina  Abi-Fadel_Vina@sac.edu Brocatio, Carlos  (Edit All)  Brocatto_Carlos@sac.edu
Abrahams, Lawrence  Abrahams_Lawrence@sac.edu Butler, Sara  (Edit All)  Butler_Sara@sac.edu

Abramovitz, Julieta  Abramovitz_Julieta@rsccd.edu Coyne, Claire  (Reports Only)  Coyne_Claire@sac.edu
Aburto, Guadalupe  Aburto_Guadalupe@sac.edu Estrada, Brenda  (Edit All)  Estrada_Brenda@sac.edu
Ackerman, Jack  Ackerman_Jack@sac.edu Gallegos, Nicole  (Edit All)  Gallegos_Nicole@sac.edu
Acuna, Jennifer  Acuna_lJennifer@sac.edu Galvan, Javier  (Reports Cnly)  Galvan_Javier@sac edu
Acuna, John  Acuna_John@sac.edu » Guerrero, Martha  (Edit All)  Guerrero_Martha@sac.edu
Adame, Al Adame_Al@sac.edu N Hoffman, Bart  (Reports Only)  Hoffman_Bart@sac.edu
Adame, Cristal ~ Adame_Cristal@sac.edu Hubbard, Vaniethia ~ (Reports Only)  Hubbard_Vaniethia@sz
Adams, Jennie  Adams_Jennie@sac.edu < Johnson, Tyler  (Reports Only)  Johnson_Tyler@sac.edu
Adams, Keyvon  Adams_Keyvon@sac.edu Kennedy, James  (Reports Only)  Kennedy_James@sac.ed\
Adams, Michelle  Adams_Michelle@sac edu << King, Jaki  (Edit All)  King_Jaki@sac edu

To remove a role from a user, select the user from the list on the right and use the arrow

{
to move that user to the list on the left. Be sure to click the Save button to save your

changes.
To add a role to a user, select a role from the Role drop down and then select the user from the

>
list on the left. Move the user to the right pane using the arrow button
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You can also use the search bar to find a particular user in the list.

Unit Role
Academic Affairs Program Sample Program Review and RAR
Eden
~ ~,
Andom, Eden  Andom_Eden@sac edu Beyersdorf, Matthew  (Edit All)  Beyersdorf_Matthew@sac e

Brocatto, Carlos  (Edit All)  Brocatto_Carlos@sac.edu
Butler, Sara  (Edit All)  Butler_Sara@sac.edu
Coyne, Claire  (Reports Only)  Coyne_Claire@sac.edu
Estrada, Brenda  (Edit All)  Estrada_Brenda@sac edu
Gallegos, MNicole  (Edit All)  Gallegos_Nicole@sac.edu
Galvan, Javier  (Reports Only)  Galvan_Javier@sac.edu
Guerrero, Martha  (Edit All)  Guerrero_Martha@sac.edu
>» Hoffman, Bart  (Reports Only)  Hofiman_Bart@sac edu
Hubbard, Vaniethia  (Reports Only)  Hubbard_Vaniethia@sz
Johnson, Tyler  (Reports Only)  Johnson_Tyler@sac.edu

Note: a user cannot have more than one role. If a user is already assigned a role, you must
remove that role from them by moving them to the list on the left side. Only then will you be able
to assign a new role to them.
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